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Install

Download PSoC Creator from www.cypress.com/psoccreator, or install from a kit CD.

For assistance, go to http://www.cypress.com/go/support

For features, system requirements, and installation notes, refer to the Release Notes available at:
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide.

Launch

Find the PSoC Creator icon to launch the tool.

Windows® 8 or above Windows 7 or before

) P5oC Creatar 4.%
L Bootloader Host
E:,'] Install Drivers for udision

4 PSaC Creator 4.}{{?

|| P5aC Creator He

PSoC Creator 4.x

You can launch the tool from the Installer application. You can also use the Windows Start key and type
“PSoC Creator” to locate it.

Create New Project

Click the Create New Project link on the Start Page to open the New Project wizard.

File  Edit iew Project Build Debug Tools Window Help
gﬂjﬁljdu‘_f_» d 53 [[3 X =Qﬂ'_ AR _

Start Page ]

Learn
Getting Acquainted
Mewy in 4%

Mewvs an rrmation

Percepio Tracealyzer and PSoC 4200M

Start
Create Mew Pro'ect...éb

[re-printed from ictespert.com by Alan Hawss]

As you have probably noticed, | have spent a significant amount o
FreeRTOS projects. One thing that | have been continuously frust
How much memory am | using? How much stack and heap are fr

Open Existing Projec

/-\ J1240jdx3 saedsyao s,

ind Code Example ..,

Kits
Posted on 07/25/2017
Recent
Workspace3Z cyrk Read More
Workspace3Loyark

Note There are also code examples available from a link on the Start Page and from the File menu.
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Complete New Project Wizard

schematics.

Follow the instructions on the New Project wizard to select/complete information needed for your
project. This wizard provides several options to create projects from code examples and pre-populated

Create Praject - CVACKIT-044 (PSaC 4200K)

Select project lype
Chanse the type of project - design, fbrary, or workspace.

Design project

(2 Je

= Select a Target kit if it is installed, or
select a specific Target module or
Target device. Then click Next >.

@ Target kit CVBCKIT-044 (P50l 4200M)

Target maduls

Targst device Create Project - CYSCKIT-044 (PSoC 4200M)

Library project Select project template

Waorkspace

Choose & schematic template or start yaur design with a kit o example project.

[ s

=1~ Select Code example
and click Next >.

11| Code example
nun| | Choose from aur library of code examples.

My Template project
Create a project from a previously saved template.

= | Pre-populated schematic
=] Start with typical MCU functions (ke UART, ADC, etc.)

Empty schematic
Create a full custom|

Select a code example

Device family: | PSaC 4200M
Filter by:

Create Project - CYBCKIT-044 (PSoC 4200M)

Documentation | 54 b

P ~

CAN_Basic_P4_Fxample
CAN_Full_P4_Example
nse_CSD_P4 Proxi
CE210291 Cap3ense_P4_

Combined_Port_Interrup
Cormparator PSoC4_Exal

Select an example from
the list and click Next >.

Click Finish to create the project.

ADC_Differential_Preamplifier -
ADC_SAR_Seq DieTemp_PSoC4
Bootioadable_PSoC4_Fxample
Bootloader_PSoC4_Exarnple

m

Laeation: C:hlsershekfDocumentsiPSoC Creator o
Project name: Clock_P4_E xamplell
fe—

Create Project - CYBCKIT-044 (PSoC 4200M)

7 )s

Create Project
Choote a name and location for your design.

Create new workspace

‘Waorkspace name: - (TSR E]

| < Back

[ FEinish

I

Cancel ‘

generate files. See also Optional: 3rd Party IDE

Note For PSoC 6 devices, the Target IDEs page displays to select one or more IDEs for which to

Integration in this document.

For more information, refer to the PSoC Creator Help topic “Creating a New Project.” Also, each code
example project contains a description document.
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Modify the Design
As needed, you can add components and functionality to modify the design to fit your needs.

For PSoC 4xxx devices, pre-populated schematics contain preconfigured Components to use in your
design. Components are divided into separate categories by schematic tabs. There is a "My Design" tab
to customize your design. You can disable individual Components or disable complete schematic tabs.

Start Page  TopDesign.cysch | « 4 b % | Component Catalog (145 co.. + & X

+| Search for & M
1 Cypress | Off-Chip ab
o nent Catalog
0 These UART, I12C and SPI in Sarial Gy Blocks (SCB). 8 Analog
SCBs support UART, SPI, 12C, and EZI2C (a simplified interface to 12C).

I There are 4 SCB blocks in all devices in the PSaC 4100M and PSoC 4200M families. L 68 CapSense

1 =\ | Bigg Communications

\ The CAN components are implemented in CAN 2.0b blocks.

There are 0 or 2 CAN 2.00 blocks in devices in the PSoC 4100M and PSoC 4200M families. i¢g Digital

= Mote that CAN reguires an accurate clock and so you musl enable EXTCLK and use it to drive SYSGLK in the CYDWR file to use these components. ieg Display

T To configure these components, simply double-click the symhol to open the parameter editor dialog. 198 Ports and Pins

o To change the selected SCB functionality, e.0. from UART to SPI. simply delete the UART then dragadrop SP1 from the Component Catalog &8 System

1 !
%8 Thermal Management
C t R UART G . I2C 126 G SPI 5Pl Gonfiguration
ategories 115200, 8., 1 F Sleve ]
Polled mode Address 0x08 1 Mbps
100kbps Motorola made
Wake from sleep CPHA=0
T Thstarc CPOL=0
« i v
*._Communication | Digital . ADC | Capsense . DAC . LCD (Disabled) | System |._ My Design b

As needed, add a Pin, Clock, and other Components to complete the design by dragging items from the
Component Catalog.

Start Page / *TopDesign.cysch ] » < b x | |Component Catalog (149 components) » 3 X
|i| & ||| Search for.. .ﬁ“ LQJ @
u-|.., PWM 1 {Ql;ygrais;lseoff-chlp 9 [i
o PWM F-&g Communications
. oV £] 84 Digital
a un =) =|| | B-@g Display
AN eerel [+ Fixed Function
-3 line & &g Ports and Pins
T Clock 1T Belock line_n = P'"—1\ & Digital Bidirectional Fin [v2.20]
fﬂ T iz interrupt (=1 e .ﬂ} Digital Input Pin [w2.20]

----- Digital Output Pin [v2.20]
g Power Supervision
FHieg System i
Open datazhest
Pinz component configured for digital output.
: )| e Pin_T
. Page 1 q Pk

If needed, connect various components using the Wire tool.

If you have complex or frequent wiring, double-click the wire tool to enable “Sticky” mode to use it
repeatedly. Then press [Esc] to return to “Normal” mode.

For more information, refer to the PSoC Creator Help topic “Schematic Editor.”
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Configure Components
As needed, configure various component parameters to modify the behavior.
Configure 'PWM' @
Mame: PWM_1]
" Configure |* Advanced | Built-n q b
%] cu ct period | #-255 0-# 255 o
23 Copy o e
4 i i
pwmz | i
Delete | Pl
Select All ct ! i
Implementation: 0
Zoom
Resolution: @ 8-Bit 16-Bit
Shape
PWM Mode: | Two Outputs T
Configure...
- Period: 255 2 Period = 21.333us
=" Open Datasheet ... = < <
= P CMP Value 1: 127 = CMP Value 2: |63 = 2
Find Example Project...
Open Component Weo
Generate Macro

For more information, refer to each component's datasheet, available from the Configure dialog, the
Component Catalog, or from the Datasheets tab in the Workspace Explorer.

Miorkspace Explorer (1 project)
Hia

& Warkspace "Workspaced7' (1Prc

~ X

= E‘ Project 'Design01' [CYBC4 0
J Iﬂ“ Tog = h &l g
H a
m
o
o
E
a
5
» ]
- Interrupts
- Systern g
& Directives §
o
: ] cyapicallbacks.h ﬁ
E}_J Source Files E—r
i el maine 2| &
4 1 F hd

Configure Design-Wide Resources

Double-click on a node in the Workspace Explorer to open Design-Wide Resources, such as pins,
clocks, interrupts, DMA, and more. Once open, use the tabs to switch between them.

CYPRESS

Start Page | TopDesign.cysch Designl]l.cydwr] * 4 b X
4 & .
tegssaaffazaxsfB Mame Port Pin Lock
. EzIsz=x GEE¥§§E§
nnnnnnn g H
P 1 POLO 39
|- ek Ol rsn [rocoy []se [-] O
+ |rant ez gy
a e w40
o et o | 1
» ot ey |44
o |ra e
] - o [ 12
o |rn - 4 s [
b CYBC4247AZIMABS i
L E4-TOFP sout [T
i 004 B
— il e
iy
H e
DWR Editor Tabs .
™M
= &z =
ffse FrIfEs
ge= El \Ya EE
\(,3 Pins ] M\ analog E,'E D G}%ocks ﬁ Interrupts - % System L) Directives J Flash Security 4

For more information, refer to the PSoC Creator Help topic “Design-Wide Resources.”
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Build the Design

After completing the design, use the Build command to generate source code.

File  Edit Miew Project Build Debug Tools Window Help

AN G b a S A8 EEX _ifoor -|® @ @A Debug
; G W o Bz ulEl==A& AT W R
V8Fkspace Explorer (1 project) v ax Start Page TopDesign.cysch] ~dpk X
a0 5] -
B Warkspace “Workspaced7' (1 Projects) E
E}E‘ Project 'Design01' [CYBCAZA7AZ] | <0>u
éf' TopDesign.cysch _E! PWM_1
: _\P Design Wide Resources (DesignlE B O PWM
; 4} Pins 0o a 3::’2 3
g _\\ cclo
o
{(8) Clacks ==
;? Interrupts ~ i n el = .
- = | line_n ] Pin_1
System z Clock_1[_}——elock
L) Directives 2 12 Mz interrupt (=1
2 Flash Security 3
EHr Header Files
i L[n] cyapicallbacksh T
E}_} Source Files E_r
~|c] main.c
E}_} Generated_So
EH) PSoC4 -
E}_} Clock_1 o El 1 2
« : Em!m — v - - Page 1 4 b

For more information about these files, refer to the System Reference Guide, located on the Help
menu, under Documentation.

Add Code in PSoC Creator

TNASH@ SR & &0 . @~ _ Debug -
-0 3 of | K 2 ==
Workspace Explarer (1 praject) 2% Start Page | TopDesign.cysch * *maind | « 4 b % ||Code Explorer (main.c) - A x|y
% 7 * COMFIDENTIAL AND PROPRIETARY INFORMATION IL' i lT' 2
3 i El .EI— 7
EHED Header Files A =) * WHICH IS THE PROPERTY OF your company. - Include directives: E
ol = T 3
----- ] cyspicallbacks.h 0 | == projecth z
569 Source Files g vl E-= Function definitions: z
3 h g
. ) 5 i tint
< [ 12 #include "project.h” @ maindin
EHED Generated_Source o s
FHO PlaCd =3 14  int mwain(wvoid)
-5 Clock_1 % 159 ¢
t-|e] Clock Le & 16 CyGlobalIntEnakle; /# Ensble global interrupts. #/
L [H) Clock_Lh 17
- cy_boo g 18 /% Place your initialization/startup code here (e.g. Mylr
23 oy boot g
L] emigeeld LA T PUM_1 5t
L Crnlaricf 3 20 & PYWM_1 SetQDMode - 3
0] CmiRealView.scat 3 2l & PWM_L SetReloadiode
€] Crmistart.c B zj & PUVM_L SetStartMode
g cmsis_armech & Ga L, % PWMLSetStophade
£ be[h] cmsis_gcoh
B core oo . & PWM_L Sleep
_cmb. sems tart wvoid PYUM_L_Start)
(1] core_em0_psacdh Do [ PWM_1START_MASK
) coreemPunch [l = PWM_L_START_SHIFT -
‘ il v (e = PWM_1 STATUS DOWN '
Output | Matice List | @ Pt 1 STATUS PTR . =
Ready In19 Col13 INS OEmors OWarnings 2Motes

Inside PSoC Creator, open the main.c file and insert the necessary code for your application.

Note For many components, you must add at least a start function to enable the component. This start
function is usually named [component_instance_name]_Start(). For more information, refer to the
applicable Component datasheet API section.

Cypress provides various PSoC Creator code example projects that can help you design faster. Open
the Code Example dialog from the File menu or Start Page. For more information, refer to the PSoC
Creator Help topic “Find Code Example.”
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Program the Device

Connect your development kit to your computer, and click Program n\#

You can obtain a kit from the Cypress web page at: http://www.cypress.com/go/store.

If your design has no errors, PSoC Creator will build the design ...

- v prruissLLn ..
L] cycodeshareimport.ld Verify Checlksum...
-] cycodeshareimportscat Finished Programming
] cydevige_trr.k Device 'PSoC 4200 CYSC42Z45AX+-48 BUlld Messa es ¥ 0z/z0,
[ cpdevi mmine | | ||mmmmm o Build Srarteds g lock P4_Exi
[ cydevice c The code generation sStep T
0 ey arm-none-eshi-goc.exe “c main.c -o .4 CortexMOYARM GCC_S541%Debugimein.o -
B yd —eabi-ar.exe -rs .\CortexM0\ARM_GCC_541%DebughClock_P4_ Examplel
Ll oy H —eabi-ar,.exe: creating .\CortexMO4%ARM GCC 541\ Debugh Clock P4 Ex:
1] oy Generated Flles —eabi-goo. exe -Wl, —-—-start-group -o "C:\Users\ckfl Documents) PSaC
- |g] cyfbormr—erm T l.exe -C "C:ihUsers' ckf)Docuwents)PSoC CreatoriClock P4 Exsawmplel:
] cyfitter_cfg.h cyelfronl.exe -5 "C:hUsersh ekt Documencs) PSoC CreatorhClock P4 _Example:|
[ cyfittergnuine Flash used: 2368 of 32768 bytes (7.2 %1. 1
[ cyfitteriarine SRAM used: 1536 Of 4086 bytes (7.5 %). Stack: 1024 bytes. Hemp: 128 by _
-] cyfitterrvinc ¢ T 3
A s - 82| :
q i v | = || outpot [ Motice List Status Indicator
[Software] IDE Library Creation.., — m Software 0Errors 04V
... and program the device.
’j cydeviceiar_trm.inc Eragramr;;nghstirted for device: 'PSoC 4200 CYBC4245AX*-483'.,
b cydeviceny trm.ine Ei:;zig =
’ 1] Eyd_'sahlethEb'h Programming of Flash Starting. ..
l] cyfittenh Protecting. ..
Lole] cyfitter_cfg.c Verify Checlksum. ..
-] cyfitter_cfg.h Finished Programming L
_] cyfittergnu.ing Device 'PSoC 4200 CYSC2245AE*-483' was successiully programmwed at 02/20,°
[ cyfitteriarinc ‘Pragrammlng started for device: 'PSoC 4200 CYSC4Z454X7-483'. il
b ] cyfitterraine 3
P weeincaca ] .
Programming Status
Frogramming 0 Errars 0

Motice List
Wiarkspace - 1€ 3 Errars|| |8 0 Wamnings | [ 1 Noted{| 6o to Error

Description

e "Pin_1", termin

If there are errors, view the Notice List window and click Go To Error to find and resolve them.

~ 1%
iewy Details

File Error Location Project

63| 2| sdb.MO0S0:Terminal "y_0" requires connection when it is visible. TopDesign.cysch |Signal: Net_d, Clock_P4_Exam...
§ |5 Pri-M11268:This build expires in 28 days. Please contact Cypress to get the latest release
| before this oceurs.
Q 4|fit.MO050:The fitter aborted due to errors, please address all errors and rebuild, Clock_P4 Exam...

Cukput | Motice List

3Errars  0Warnings 1 MNotes

Next Steps

notes, and training videos.

Now that you have created a design, open a few example projects and explore different ways to
improve it. The PSoC Creator Help and various documents are available from the Help menu.

Refer also to the PSoC Creator web page for more information, such as design guides, application
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Optional: 3" Party IDE Integration
firmware.

open the IDE Export Wizard.

If preferred, you can use your PSoC Creator design with a 3™ Party IDE to code, debug, and test

For PSoC 3, PSoC 4, PSoC 5LP, and FM0+ devices, select Export to IDE from the Project menu to

Eile  Edit  Wiew

Project | Build  Debug  Tools  ‘Window Help

[ wWorkspace Design

=8| Proiect ‘Des|

‘ﬂ‘ TopDesign. Rernove From Wiorkspace

’ ﬁg Design24.c Unload/Reload Project

[FHLED Header File;

i n] devieed 4 New Folder

EHED Souce Files 2y Shaw &l Files

| 8 maine Set As Active Project

EHED Generated | e hhtabie
EHLD P5eC3 Set A3 Top Component

515 A S Newlem.. l;:_is ]

- 2 B \g Bl Add Component Tterm,., 10 '_
|Workspace Explorer |[]  Esisting Itern.. an.cysch
G 4 Import Cornponent..

Update Compaonents (Design24)...

Dependencies..,
Build Order...

Device Selector.,

Archive Warkspace/Project...

Ezport to IDE (Design24)...

IDE Export Wfizard - PSoC4200
Welcome to the IDE Export Wizard

Exporting a praject to an external IDE allows you to develop firmware
[including programming and debugging] in your IDE of choice.
Export to:

To continue, click Mext.

(-2l

nent Catalog {

®ou

)

Ipress t OFf-C

) @ Eclipse Filters
Parts and Ping
@ x 14F Embedded ‘orkbench for ARM |} Analog Pin
& Digital Bidire
.:‘ Wision |2} Digital Input
. |2} Digital Dutp
-?- Generated Ch515-Pack (Beta) Power Supsrvis
. Sustem
) 4 Makefile [#] Boost Conw

[¢] Bootlnadab
%] Bootloader
o] Clock [v2.0

Caen |

Cancel ] [ Help

|

nent Preview

Y

<1|>‘

2 DesignZ4 Resources

ehug
ustom
eriphe

get [l

- Code Generation

- ARM GCC 5.4-2016-52-upe

L2 [

Build Settings
Configuration: [ Debug [Active] h ]
Toolchain: [AHM GCC 5.4-2016-g2-update ']
E-Design0l

CMSIS Pack:(1) | Disable

AR Ew-ARM: [ Disable

izer

Makefil: [Disable

ral Driver Library
DEs

Ok

Refer to the PSoC Creator Help topic “Integrating into 3rd Party IDEs” for full details.

Dratashest

For PSoC 6 devices, this step is included as part of creating a new design. You can also select Build
Settings from the Project menu, and then select Target IDEs.
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© Cypress Semiconductor Corporation, 2010-2019. This document is the property of Cypress Semiconductor Corporation and its subsidiaries, including Spansion LLC
(“Cypress”). This document, including any software or firmware included or referenced in this document (“Software”), is owned by Cypress under the intellectual property laws
and treaties of the United States and other countries worldwide. Cypress reserves all rights under such laws and treaties and does not, except as specifically stated in this
paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights. If the Software is not accompanied by a license agreement and you
do not otherwise have a written agreement with Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license
(without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code form, to modify and reproduce the Software solely for use
with Cypress hardware products, only internally within your organization, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly
through resellers and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress’s patents that are infringed by the Software (as
provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware products. Any other use, reproduction, modification,
translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS DOCUMENT
OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without further notice. Cypress does not
assume any liability arising out of the application or use of any product or circuit described in this document. Any information provided in this document, including any sample
design information or programming code, is provided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the
functionality and safety of any application made of this information and any resulting product. Cypress products are not designed, intended, or authorized for use as critical
components in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or
systems (including resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other uses where the failure of the device or
system could cause personal injury, death, or property damage (“Unintended Uses”). A critical component is any component of a device or system whose failure to perform can
be reasonably expected to cause the failure of the device or system, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby
do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses of Cypress products. You shall indemnify and hold Cypress
harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or death, arising from or related to any Unintended Uses of
Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-RAM, and Traveo are trademarks or registered
trademarks of Cypress in the United States and other countries. For a more complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed
as property of their respective owners.
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